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From The Editor’s Desk

PhotographyBB Online Magazine Issue Nineteen: How to?

Dave Seeram is the Editor in Chief for PhotographyBB Online Magazine. As 
the administrator of the PhotographyBB Website and Forums, Dave is also 
an experienced author of several Photoshop® Actions and Tutorials which 
can be found on http://www.PhotographyBB.com

Welcome to our 19th edition of the PhotographyBB Online Magazine! As many of you know, 
the Scott Kelby WorldWide Photowalk was held in July, with the results of the winners 
having been posted on August 17th. If I may take a brief moment to toot my own horn 

(which I actually don’t enjoy doing!), I would like to humbly announce that yours truly was selected 
as the winner for the Vancouver (Canada) walk! Additionally, our own Jason Anderson won top 
pick for his photo from the Denver (USA) walk, and John Ogden (who won his walk last year) 
graciously hosted the photowalk in Reading (UK). Congratulations guys, and to all the winners 
who were selected from the over 900 cities who participated.

This month, the focus is all about “How to...” The contributing authors have put together this 
issue featuring a series of practical articles demonstrating techniques to help all of our members 
explore and improve. One of our most exciting features this month is from Jason Anderson who 
gives us a look at getting started with basic backyard Astro-Photography. If you’ve ever wanted to 
take great moon photos or starfields, then this is the article for you. Jason has also included a link 
to a YouTube video he put together on building an inexpensive “star tracker.”

In continuing with the “how to” theme, I would like to welcome David Hegarty who is 
contributing a two-part series on how to shoot and process panoramic photography. Additionally, 
John Ogden is continuing the series on Portraiture Photography 101, teaching us the importance 
of using lighting and form in portrait work. Continuing with our popular FAQ series, Colin Bell 
examines some of the common questions surrounding bridge vs DSLR cameras, what to do 
when you get your new DSLR, and whether or not digital technology can make you a better 
photographer.

Have you ever wondered if Flickr was right for you? Jon Ayres gives us a look at how using 
Flickr to host your own private gallery showing can expose your work to (potentially) millions of 
world wide viewers, and may possibly lead to sales of your photographer outside of Flickr.

We would also like to welcome our long term forum member Alan Plummer (cardmnal) as 
our Photography Around the World author this month, who gives us a look at two of America’s 
most spectacular national parks, Yellowstone and Grand Teton. Additionally, John Krzesinski joins 
us in the spotlight interview this month, sharing some of his outstanding work along with some 
valuable photography insights.

Lastly, in our Photoshop tutorial this month, Jennifer Farley shows us how to create a Polaroid 
style effect, and even add some handwritten text to the bottom of the image. This is an excellent 
technique for scrapbooking or displaying your holiday photos online, so check it out!

Thank you again to all of our hard working contributing authors, and to our readers who 
appreciate all of the work our team puts into each issue. Now on with the show!

Dave Seeram
Editor and Publisher
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Photography is a difficult profession; 
earning a comfortable living from the trade 
can be difficult and it is often a struggle 
to make ends meet. Anyone who says 
differently is either fooling themselves or has 
already got passed the struggle of building 
up a reputation for themselves. It doesn’t 
come easy, that’s for sure. However, many 
of us remain blind to the truth, cocooned 
in our own little bubble of denial and self 
preservation. 

I can remember in photography school, 
one of my classmates saying that there is no 
money in photography and it is really just 
a part time career. At the time I scoffed at 
the idea. I thought to myself how I, Kenneth 
Fagan, could ever be left short of money 
with such talent that I possess - I am going 
to be the best of the best! Those were the 
exact words I thought of when I heard him 
say that. Boy was I wrong. Once I graduated, 
full of mad ideas and confidence, I was ready 
to take on the photography world like no-
one else. That soon came to a halt like a 
startled horse at a jump. I quickly realized 
that those ideas of mine were not that of a 
photographer (never mind a professional 
photographer) but of an elitist fool who 
believed everything was going to be great. 
I thought I knew everything but the fact is 
I didn’t realize I still had so much to learn. 
Today, I have long accepted the fact that 
photography as a profession can take 
years to perfect and the day I stop learning, 
like everyone else, will be the day I stop 
learning.

From that experience I have become 
more aware of the photographers around 
me; I see honest ones, not afraid to make 
a fool of themselves by asking what they 
believe to be a silly or downright ridiculous 
questions. If you ask me, the ones who 
ask the questions now will be the ones to 

reach the most success in the future. I also 
see the photographers who are purely in 
it for themselves; these are the elitists of 
the photography world, living in a society 
of self preservation and self satisfaction. 
They ask no questions because they believe 
they know them all already, and they don’t 
answer any either because they believe that 
it will only reveal their secrets. Trust me; 
elitist photographers have nothing worth 
knowing. The worst kinds are those who 
need help but won’t accept it from anyone, 
and if you try to help they just get offended. 
These photographers progress slowly up 
to a point and then they just don’t get any 
better, stuck in a rut because they were too 
stubborn to ask why the horizon lines are 
crooked or how come the background won’t 
go blurry. 

It’s a sad state of affairs to see this with 
the more experienced photographers who 
have been around for many years, well 
prepared to show off their own talents but a 
bit slow about complimenting those around 
him (or her). It doesn’t matter where you 
have been, how many countries you have 
travelled, or even if you haven’t got beyond 
the boundaries of your own town with your 
camera, there is room for everyone. We all 
need encouragement and everyone needs a 
compliment of some sort. A photographer, 
no matter how talented will always need it to 
enable him or her to continue with it whether 
they are just an enthusiast, an amateur 
or even a professional. Don’t be afraid to 
compliment another photographer’s work, 
make suggestions and always critique but 
never criticize. If you feel that I am finger 
pointing towards you here, well I am; and 
if you believe I am, you are possibly one 
of those who are convinced that you don’t 
need to associate yourself with the riff-raff, 
otherwise you will not have been offended 
by it!

PHOTOGRAPHY:THE PROFESSIONALS AND THE ELITISTS - By Kenneth Fagan

Confessions of a Photographer...
EDITORIAL THOUGHTS, FACTS, AND OPINIONS FROM THE TEAM AT PHOTOGRAPHYBB.
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SET UP YOUR OWN PRIVATE ONLINE GALLERY SHOWING

What photographer whether they be an amateur or a professional has not dreamed a little of having their 
own private showing in an art gallery? It’s only natural since photography is an art form and in reality as 
much of an art form as any other type of art.  Imagine your own private showing where visitors from all 
over the world can view, critique, give advice and just like an art gallery on the street, and can also give 
the artist feedback on their work, which can possibly lead to sales of your photography.

Sure, you can setup your own web gallery, but it is 
not always practical in that you have to really work 
your butt off letting people know about your site and 

getting them to visit to your site.  You can go with one of 
the online stock photo agencies if you’re interested mainly 
in selling your photos, but stock agencies are (sort of ) not 
as well thought of by magazines and newspapers as they 
once were.  Posting your photos in various photography 
forums like PhotographyBB can help you get some good 
feedback and show your work, but forums can still be 
somewhat limiting in who sees your work since forums 
only attract people interested in what the forum is about.  
You are seeking exposure to your work and this means you 
want as many people as possible to see your work.  But 

there is an alternative if you’re seeking to expose yourself; 
I mean your work to a large number of people all over the 
world, pretty much like a showing in a brick and mortar 
street art gallery.

When I first heard of Flickr, I really was not too 
interested in their operation, mainly from what I had read 
on other photography forums about Flickr and from what 
I saw, many of the posters were not exactly what I call 
friendly.  But after dealing with many members from online 
photography forums, everybody on Flickr were angels.  
Still, I was hesitant about joining Flickr because I thought 
my work could be downloaded and used easily without my 
permission, until I started reading a little about Flickr and 

with flickr® By Jon D. Ayres
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I not only changed my mind, but for the first time ever, I 
bought a paid membership with a photo posting site.  I’ll 
explain why I decided to go with Flickr.

Flickr is the largest photo sharing site there is.  There 
are none larger, with people from just about everywhere 
in this world of ours as members.  Because of its size, 
Flickr attracts a lot of attention, even one of the world’s 
largest stock photography agencies now search Flickr for 
photographers to invite to Getty Images.  Now let me say 
right off, Flickr is not a stock photography agency, Flickr 
is a photo sharing site; the largest photo sharing site in 
the world.  If Flickr catches you trying to sell your photos 
from their site, you will be banned.  I think that is one of 
the things that make Flickr so good.  However, just because 
Flickr does not allow selling of your photos does not mean 
you can not make sales.  You have to do it on the side with 
little if any involvement with Flickr.  I have read that a lot of 
magazines and newspapers now go to Flickr to find photos 
instead of the stock agencies.  In some rare cases, your 
photo may be taken without your permission, but most 
legit magazines and newspapers will ask your permission 
first and sometimes make an offer to you in order to use 
your work.  Since it is done between you and the magazine 
through email, Flickr really has nothing to do with it.  Only 
if you openly try and sell your work through Flickr will you 
find yourself in trouble, so do not try that.  Making sales 
is not why I joined Flickr. It was the exposure my photos 
and digital art was getting from all over the world.  I now 
live in Moscow, Russia, so naturally I have posted photos to 
Flickr discussion groups on Moscow and the surrounding 
area. Also I have posted some to digital art groups, and 
Orthodox Church groups since many of my photos are of 
Russian Orthodox churches.  It did not take long before 
I started getting noticed more and more and invited to 
make submissions to various Flickr discussion groups.  Of 
course you can not just upload your photos and expect 
people to find them, you have to join discussion groups 
and submit photos to them, you also have to comment on 
others work.  By doing this will draw attention to your work 
and your gallery.

Like I said before, Flickr is the largest photo sharing site 
in the world and because of that, it automatically draws 
attention from all over the world.  I’ve mentioned Getty 
Images, newspapers and magazines, but did you know 
that museums also look at Flickr, just in case they find a 
special photographer or digital artist they can offer to 
give an exhibition to in their museum.  That is why Flickr 
can make the perfect online portfolio.  Even if you’re a 
professional photographer, you can upload low resolution 
copies of your work and make a portfolio that not only will 
be seen by people all over the world, but also you can show 
it to potential clients. Just make sure you do not mention 
anything about selling or prices on your Flickr gallery, that 
has to be done privately, only between you and your client.  
For example I mainly only upload low resolution photos, 
and if some one is interested in my work, they can email 
me and we will discuss it and if we come to an agreeable 

understanding I will email them a high resolution copy of 
the low resolution photo I have on Flickr.  Sometimes I will 
give photos away to non profit organizations if I agree with 
what they are doing for them to use, all I ask is I be given 
credit.  

I know when I first thought about uploading photos to 
Flickr I was concerned about my photos being taken and 
used without my permission.  Even though the only real way 
to protect your photos is not to upload them, I have taken 
steps to make it harder.  First, as far as photos go, I resize 
most photos to 800 x 600 pixels.  That resolution is next to 
useless for magazines or newspapers or most other uses.  
Next, all my work is “all rights reserved.”  Flickr does have 
other rights options you can use to give somebody free 
reign to download and use your photos, but I prefer to keep 
all my work as “all rights reserved.”  Basically, this means ask 
first or get in trouble if you take it and use it without asking.  
Next, I have it set where only Flickr members can download 
or copy my photos.  I sometimes change it to where only 
my friends and family or contacts can download or save 
my work, but I generally leave it where Flickr members 
can download or copy my work so they can view the full 
size work I uploaded.  By allowing only Flickr members 
to download my work, I will know when ever somebody 
downloads my work and who they are.

Flickr has a free account, where you can upload 200 
photos, after you upload 200 photos, your oldest photos 
will be replaced by the newer ones. I started with the free 
account and liked it so much, I decided to pay fro the pro 
account which is $24.00 per year, $2.00 per month; very 
reasonable for everything you get plus unlimited uploads 
(really 3 gigs per month). 

People from all over the world have seen my work 
through Flickr, especially my digital art which is something 
I enjoy doing.  I learn about new programs to try out and 
get good critique about my work and I am happy that many 
Flickr discussion forums have invited me to submit my 
work.  Flickr really is a good resource for the photographer.  
Yes, it’s a photo sharing resource, but to me, photo sharing 
is sharing my work and photos with others so they can see, 
learn and critique my work.  Yes, Flickr has lead to a few sales 
being made by people who viewed my work and wanted 
to purchase a copy, but it was done outside of Flickr. So if 
your looking to have your work shown in what could be 
the largest photography and digital online art gallery there 
is, just set yourself up a free Flickr account and start you 
own photo and digital art gallery.  You can take measures 
to protect your work from making your gallery private, 
to forbid download and copying of your photos, or allow 
everybody to copy and download your work.  So join the 
largest photo and digital art online gallery and have your 
work seen by people from all over the world.  I think you’ll 
be like me, very grateful that you did.  

To view my Flickr gallery, please visit:
http://www.flickr.com/photos/jonayres/

This article and all images contained are Copyright © and courtesy of Jon D. Ayres. Please contact the author directly with any questions.
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The human history in Yellowstone National Park 
began over 11,000 years ago when indigenous 
Americans began living there. More recent 

history began in 1806 when John Colter, a member of 
the Lewis and Clark Expedition, left to join a group of 
fur trappers. After splitting up with the others in his 
party in 1807, Colter passed through a area of what 
later became the park, during the winter of 1807–1808.  
He observed geothermal areas and, after surviving 
wounds he suffered in a fierce battle with members of 
the Crow and Blackfoot Indian tribes in 1809, he gave a 
description of a place of “fire and brimstone” that was 
dismissed by most people as delirium.

On March 1, 1872, President Ulysses S. Grant signed 
The Act of Dedication into law that created Yellowstone 
National Park. The 3,468 square mile park was the first 
of its kind and is comprised of lakes, canyons, rivers 
and mountain ranges. 

In the 21st century, the Yellowstone Ecosystem is 
visited by nearly 3 million people per year. They come 
to see the inspiring landscapes, thunderous waterfalls, 
colorful pools, roaring geysers and a myriad of flora 
and fauna.

My trip begins in the town of Jackson, Wyoming. 
Jackson is considered the gateway to both Grand Teton 
and Yellowstone National Parks. It should be mentioned 
here that the two national parks, the surrounding 
forests and wilderness areas are all considered part of 
the 20 million acre / 31,250 square-mile (8,093,712 ha / 
80,937 km) Greater Yellowstone Ecosystem. 

As we head north past the National Elk Refuge 
we enter into Grand Teton National Park, and are 
immediately taken back by the site of the Teton 
Mountain Range rising 7,000 ft. above the sage and 
chaparral covered valley floor. Between six and nine 

Photography Around the World 
PHOTOGRAPHIC EXPLORATIONS OF OUR BEAUTIFUL AND MAGNIFICENT PLANET EARTH

NORTHWEST WYOMING - THE GREATER YELLOWSTONE ECOSYSTEM -  By Alan Plummer
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million years ago movement began along the Teton 
Fault near what is now the border of Idaho and 
Wyoming. The west block pushed upwards creating 
the mountain range while the east block dropped 
creating the valley known as Jackson Hole. Shooting 
photographs in this scenic wonderland can yield 
breathtaking results.

We can choose to turn onto Antelope Flats Rd and 
drive back to the Mouten barn, a very photogenic old 
homestead. The Teton Range serve as a background to 
the often photographed location and it is an ideal spot 
to capture the sunrise.

Fed by melting snow and lakes, the Snake River 
winds its way across the valley floor on its path to the 
Columbia River and eventually to the Pacific Ocean. 
A number of pullouts are located along the highway 
where one can take excellent photos of the mountains 
and the river. The most famous of these would be the 
Snake River Overlook, where Ansel Adams made his 
famous image.  

The valley is home to a tremendous array of 
wildlife so we keep our eyes open for moose, bison, 
elk, antelope, grizzly and black bear, wolves, coyote 
and foxes. Often the mere presence of the animals near 
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the side of the road will create traffic jams of excited 
vacationers trying to get a closer look.

At the foot of the mountains are a number of 
small lakes that were carved out of the mountains by 
glacial movement. They are surrounded by forests of 
lodge pole pine, blue spruce and a number of other 
evergreens as well as quivering aspen, white birch and 
cottonwoods. A few, such as Jenny Lake and Spring 
Lake, are accessible by car while many others must 
be hiked to. Regardless of which lakes are visited or 
how you got there, all offer breathtaking beauty and 
limitless photographic opportunities.

A little further north we come to what is probably 
the most photographed place in the park, Oxbow 
Bend. Though most have never heard of it almost 
everyone has seen it in magazines, movies and other 
media. This scenic bend in the river on windless days 
feature a reflection of Mount Moran in its waters 
and is considered an iconic photographic location. 
Professional and amateur photographers alike travel 
here from the world over searching for its famous 
alpenglow and the perfect shot.

A couple of miles past Oxbow Bend we encounter 
Jackson Lake. The headwater for the Snake River, 
Jackson Lake is a large lake with a few lodges, cabins 
and marinas along its eastern shore. The lake’s natural 
backdrop of Mount Moran and the rest of the Teton 
Range make it a natural subject for photographers. 
Hike any of the lake shore trails to get different angles 
and as always, keep an eye out for wildlife. In the Colter 
Bay area in particular hiking along the Swan Lake trail 
can find you in the company of trumpeter swans, 
moose, elk and even grizzly bear so do not hike with 
your camera in your bag.

Further north is the entrance into Yellowstone 
National Park. Between May 1st and October 31st, most 
of Yellowstone’s park roads are open to motor vehicles. 
The loop road is shaped somewhat like a figure eight 
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and is comprised of 154 miles of roadway. This loop 
road will take you within fairly easy walking distance of 
most of the parks photogenic features.

Within a matter of minutes after entering the park 
we traverse the small rock bridge over Crawfish Creek 
and pull into a parking area. About a hundred yards 
from here is Moose falls, one of my favorite spots. 
Moose Falls is a medium size waterfall surrounded by 
forest and cannot be seen from the road. There are 290 
waterfalls in Yellowstone at least 15 feet or taller. Some 
are easily viewed from the road or a pullout. Some have 
special parking that can accommodate tour buses, and 
others like Moose Falls, are not well marked and are 
overlooked by most. 

There are two primary ways to photograph 
waterfalls. The first is to shoot the subject with a fast 
shutter speed (1/60th to 1/100th of a second). This will 
freeze the action and render the waterfall as we see 
it with the naked eye. This is great for demonstrating 
the fullness and power of the waterfall. The other is to 
shoot at slower shutter speeds (1/4 to 1/2 of a second) 
which allows for motion blur and creates a more 
ethereal image. This works best in low light conditions 
and you will want to be sure to use a tripod.

Most photographers will base their artistic choice 
on the size and power of the waterfall. Shooting major 
falls like Upper and Lower Falls of the Yellowstone is 
usually done with a fast shutter speed while the more 
delicate, lacy falls are often shot with slower shutter 
speeds. Medium sized falls such as Moose Falls and 
Gibbon falls can be shot either way often depending on 
the time of year and fullness. I suggest you experiment 
both ways to get the best results.

As we drive along the Lewis River and the Lewis 
River Canyon, the landscape changes dramatically 
from lush forest to deep granite walled canyon. Often, 
the cliff walls along the road are lined with talus, banks 
of broken rock, and evidence of the great Yellowstone 
fires can be viewed on both sides of the river. Again back 
into forest we passed trailheads, lakes and waterfalls.

I have once heard that West Thumb geyser basin 
was not worth stopping at as it was too small and did 
not offer the drama of places like Old Faithful. Well, I 
don’t buy into that and make this one of my regular 
stops. There are some beautiful pools and springs 
here. 

With the proper lighting, Abyss Pool is one of 
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the most beautiful in the park in my opinion and 
Yellowstone Lake makes a good backdrop for many 
images shot here. With 110 miles of shoreline the 
136 square mile Lake is the largest high mountain 
lake above 7,000 feet in North America. 400 feet at its 
deepest point, the lake sits atop of the center of the 
Yellowstone caldera.

Most of Yellowstone sits in a caldera. It is considered 
a super volcano by scientists because it has been 
formed by many violent eruptions over the past 17 
million years. Like Hawaii, Yellowstone sits atop what 
is considered a hotspot on the Earth’s surface which 
accounts for the volcanic activity. This volcanic activity 
is the energy source for Yellowstone’s geothermal 
features such as geysers, hot springs, mud pots and 
colorful pools. There are 300 geysers in Yellowstone 
and a total of at least 10,000 geothermal features 
altogether. Half the geothermal features and two-
thirds of the world’s geysers are concentrated here.

Thermal features are the most popular and 
interesting photographic subjects in Yellowstone. 
They exhibit power and beauty while presenting some 
unique challenges. Most successful photographs of 
geysers and hot springs are created when the sky is 
clear or only has a few clouds. In overcast conditions 
plumes of water and steam tend to blend with the 

background creating flat, uninteresting photographs. 
Blue skies create a nice contrasting background for 
geysers and get reflected in the pools and hot springs.

Geysers, hot springs and mud pots are best 
photographed with the wind at your back. This blows 
the steam away from you and allows you to see and 
photograph the subject much better. Interesting shots 
of geysers can be achieved with the wind blowing the 
steam sideways as well. Be sure to compose the shot to 
one side so that you capture the plume of water as well 
as the steam drifting off.

For successful geyser photography you need 
both patience and luck. Check with park personnel 
for the most up to date information on geysers and 
other thermal features. They record timing and 
characteristics of the eruptions of the parks major 
geysers and try to predict the time of the next eruption. 
Some, such as Old Faithful, erupt fairly regularly and 
other can be predicted within a matter of hours. Most 
of the geysers are unpredictable and can erupt at any 
time or not at all. This is a highly volatile area where 
super heated volcanic material meets water. There 
are many dynamics involved in this thermal activity 
and it subject to change at any time. A little luck and 
good timing enhance your chances of witnessing and 
photographing a once in a lifetime eruption.
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When you do get an eruption prediction it is best 
to arrive early. This will give you time to scout the area 
and analyze composition, lighting and wind direction 
in order to pick the best vantage point for your 
photograph. Watch for lines and patterns leading to 
the feature including runoff streams and boardwalks 
and include them in the composition. Runoff streams 
may be brightly colored from bacteria and algae and 
will add color and depth to your image. Experiment 
with lighting. Side lighting generally works best but 
backlighting will also work well.

Getting correct exposure in a geyser basin can be 
difficult. The camera’s exposure meter is affected by 
the light colored rock around most thermal features as 
well as the brightness of the water. Most of the time 
this problem can be solved by giving the shot one half 
to a full stop more exposure than the camera’s meter 
indicates. Be sure to bracket your shot by at least half 
stop intervals.

Geothermal features, particularly the colorful 
pools and hot springs, can be photographed during 
the middle of the day with great success. In fact, this 
is the best time to photograph many of the pools. In 
the morning when the air is cool and still there can be 
so much steam that getting a good image of a colorful 
pool is near impossible. 
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Throughout the entire park be sure to keep an 
eye out for wildlife. There are basic rules for viewing 
and photographing wildlife which should be strictly 
obeyed. Always stay 25 yards from wildlife, even birds, 
and at least 100 yards form bears. The rules are in effect 
not only to protect the animals but to protect people as 
well. Every year there are a number of incidents where 
people suffer injury as a result of getting to close. These 
animals are wild and unpredictable.

Bison can also be seen throughout the park. In 

open spaces like the Hayden Valley it is not uncommon 
to find large herds on and near the roadway. Bears, elk, 
and deer also frequent most areas of the park.  Be sure 
to bring telephoto and/or zoom lenses in order to get 
good captures of these creatures.

While bison can be spotted most anytime of day, 
mornings and evenings are the best times to see most 
wildlife in open areas. During the midday heat they 
tend to keep to the brush and shadier areas of the 
park. In my experience moose are not as plentiful in 
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Yellowstone as they are in Grand Teton National Park 
but they are around.

Climate

Most of the Yellowstone Ecosystem sits in 
higher altitude areas. In the summer expect 
daytime temperatures in 70 to 80 degree Fahrenheit 
temperature range with rare days in the 90s. Afternoon 
thundershowers are common and snow is possible 
even in July. Always be sure to check weather forecasts 
and take appropriate clothing. An easily carried light 
jacket or small plastic poncho is advisable for hiking as 
the weather can change without warning. Evenings are 
mild and can drop into the lower 40 or even 30s in the 
summer. At this high altitude the sun can be intense so 
be sure to bring sun block.

Winters can be brutally cold as -35 degrees is 
not on common. Even with the cold and enormous 
snowfall both these parks offer marvelous opportunity 
for photographers and outdoor enthusiasts during the 
winter months.

What to Bring

Travel light when visiting this area. You will often 
find yourself straying from the road and carrying much 
of your gear with you, so you need to be fairly compact 
as well. I generally take two cameras. A 28mm-135mm 
zoom lens on one for general shooting and on the 
other is a 100mm-400mm zoom for shooting wildlife. 
I also carry a wide angle lens. You will want to have a 
variety of filters available as well as flash and tripod. 
I pack my gear into a Lowpro Rover AW II backpack 
type camera bag which keeps one camera and lens 
in the bottom half (the other I carry). The top part can 

carry other photography gear, snacks, a poncho and a 
few plastic bags to keep it all dry should the weather 
change. Be sure to bring plenty of flash cards and a 
good power source.

Plenty of proper clothing is essential, especially 
if you intent to go into the back country. Either bring 
fresh drinking water or bring a way to purify the water 
you collect from streams. It may look fresh but there 
are a lot of bacteria that can cause Giardia and other 
intestinal illnesses. Also, you do not want to forget the 
mosquito repellent and sunscreen.

Although well maintained, park trails can be steep 
and rough. Be sure to bring a well broken in pair of 
hiking boots and good socks.

Where To Stay

There are a number of towns near the entrances 
of the parks that offer lodging. These are; Jackson 
and Teton Village to the south, Gardiner to the 
north, West Yellowstone to the west and Cody to the 
east. Within the parks there are a number of lodging 
opportunities some which are quite expensive and 
others relatively inexpensive. There are lodges, cabins, 
or bungalows available in most of the busier areas as 
well as campgrounds with hook-ups for RVs to more 
rustic campgrounds for tenting. For those who are a 
little more adventurous there are a few campgrounds 
with no amenities. Although they are scattered about 
and more difficult to find these campgrounds cost 
nothing to stay at, and therefore are worth it to the 
frugal traveler to seek out. Availability is limited and 
reservations were accepted and highly recommended.  
Contact the park’s visitor’s service or browse their 
websites for more information.

This article and all images contained are Copyright © and courtesy of Alan Plummer. Please contact the author directly with any questions.



YELLOWSTONE & GRAND TETON PHOTOGRAPHY: By Alan Plummer

This article and all images contained are Copyright © and courtesy of Alan Plummer. Please contact the author directly with any questions.
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Q: People often say that if you want to get better at 
photography, shoot manual mode.  Is this true, and 
why?

Shooting in manual mode certainly offers you 
some advantages over auto-modes. It forces you to 
understand, so initially shots may be worse, however, in 
order to get “good” shots you need to fully understand.  
Manual in its own right does not create better pictures 
– but when you switch back to Av mode after using 
manual, you’ll have a better appreciation of how 
everything works.  Of course a good photo is not just 
about getting the exposure right (although it is a 
fundamental part) – so there is no harm in shooting 
in Av or even ‘P’ mode if you decide you want to 
concentrate on composition and style aspects of your 
photography.  The trick is knowing when it is a good 
idea to switch back to manual mode.

Q: Does shooting digital (as opposed to film) make 
you a better photographer?

I’ve seen some great debates online on this topic 
(and participated in more than a few of them).  And I 

always like to throw in a controversial curve ball into 
the debate by giving my vote for YES.  Of course it 
depends on the criteria you use to decide how good 
a photographer someone is.  Let’s consider a few 
possibilities.

Quality of Results:  Shooting digital allows you to 
take a lot more images (since you don’t have to worry 
about cost to the same extent as film).  Therefore if you 
pick your top 5 images from a days shooting, they will, 
more than likely, be better than had you just shot a role 
or two of film.

Instant Results: The instant feedback afforded by the 
LCD screen on a digital camera means you can decide if 
you are happy with a shot or whether you should take 
it again – ultimately this too leads to better results

Low Cost: The low running costs and LCD feedback also 
allows you to not just take the shot you think you are 
after, but gives scope for experimentation.  It is this 
experimentation that will allow anyone to progress 
quicker along the learning curve.  It even gives 
amateurs and hobbyists an opportunity to develop 
a distinct style or technique to make their pictures 
stand out in the crowd.

I should point out that if you use a digital in exactly 
the same way you use a film camera, then you probably 
won’t get better results, and therefore it is unlikely to 
make you a better photographer.  However I think you 
only have to look at the quality of results appearing 
on web sites like Flickr.com by photographers that 
have only been using a camera for 12 months to see 
that digital imaging really can make you a better 
photographer.

The downside I often see quoted for digital is 
that is stops people needing to learn and they get 
good shots by sheer luck.  Some people will get 

Welcome to our 4th FAQ column, where we’ll explore more of our reader questions. Quite often, 
for both beginners as well as experienced photographers, we come across some common and 
sometimes recurring issues; here’s where we’ll do our best to address them, and get you the 
answers you need! Remember to let our Editor (Dave) or I know if there are any questions that 
you think should be included in future FAQ columns.

Frequently Asked Questions

MANUAL MODE, BRIDGE CAMERAS, AND DSLR VS. FILM:  By Colin Bell

A BEGINNER’S GUIDE TO THE MOST FREQUENTLY ASKED PHOTOGRAPHY QUESTIONS
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great shots without ever understanding what an 
aperture and I am not saying these people are better 
photographers.  But if you are someone that strives 
to be a better photographer and puts in the effort to 
learn, then digital will definitely help you achieve this 
and therefore I contest that the answer to the original 
question is YES!

Q: What does a DSLR offer over a prestige compact 
or bridge camera?

If you look down the feature list of high-end 
compact cameras you may wonder why anyone would 
want to carry around a large DSLR.  They can match 
them on megapixels and, in terms of features, the list 
for a compact can often exceed that of a DSLR.

With some more expensive compacts even looking 
like a DSLR, it’s easy to confuse them.  So what does a 
DSLR offer for the extra money and weight?  Here’s a 
few of the advantages that apply in most cases...

• Buying into a complete camera system
• Much faster autofocus 
• Faster continuous shooting modes 
• Larger sensor means much better image quality,
  especially in low light conditions 
• A true optical viewfinder 
• Higher quality optics (even on the standard kit lens) 
• More rugged and better sealed from the elements 

• Greater creative control over depth-of-field due to
  larger sensors
• A proper focal-plane shutter rather than an
  electronic shutter

So, does the prestige compact offer anything over 
the DSLR?

• Usually cheaper
• Smaller and lighter

This picture was taken by my 7 year old daughter – her use of a digital camera has allowed her to experiment and create pictures that she would never 
have had the opportunity to do with film.

This Fuji camera may look like a DSLR but it is very much a ‘not so 
compact’, compact camera, especially in terms of its autofocus and low 
light performance.



Pa
ge

 18

PhotographyBB Online Magazine

• A long zoom range without having to change lenses 
• Live-view (the ability to compose your picture on the LCD screen), although this is appearing on most modern 
DSLRs
• Macro mode - a DSLR’s closest focusing distance is lens dependent and with the standard kit lens is usually about 
30cm.  Some compacts can focus as close as 1cm 
• Movie mode / sound recording (also starting to appear on DSLRs)
• Naturally larger depth-of-field due to the smaller sensor.
• Complex computer algorithms such as face recognition, panoramic stitch assist, etc.

A general comment about DSLRs versus compacts is that under ideal lighting conditions when you’ve got time 
to compose the shot, the image from a DSLR and a compact will be pretty much identical.  Where a DSLR comes 
into its own is when the conditions start to get more tricky – the light level drops or you are shooting fast moving 
subjects.  Then you will need the speed and creative control a DSLR offers.

 
A DSLR’s priority is to capture the best image possible, with speed and quality as the primary aims.

Q: I’ve just taken delivery of a new DSLR camera – what should I do first?

1. Put your battery on charge – it will take a few hours so do it straight away and carry out step 2 while it’s 
charging.

2. Read the manual – this is not something that you do 9 months later.  Find a quiet spot and find out what all the 
buttons do, and where in the menus you can find everything.  It will save you time in the long run, and what else are 
you going to do while impatiently waiting for the battery to charge?

3. Check everything works.  Take a few test shots with the kit lens at both ends of the focal length range and at 
different apertures.  Check that the image is sharp (at f/8 it should be very sharp, even with a cheap kit lens), that it 
locks on focus, and that the exposures look okay.

4. Start planning your next purchase – an ultra-wide angle lens maybe, or possibly an external flashgun?  At the 
same time think up a few excuses to tell your partner why such extras are absolutely essential.

5. Most importantly - Go out and have fun!

If you have a specific question you would like answered, please send them to me or Dave Seeram and we may be able to 
include them in a future issue (anonymously of course). Questions are encouraged, so let’s have them!

This article and images contained are Copyright © and courtesy of Colin Bell. Please contact the author directly with any questions.



If you want to retain that viewer attention (and 
who doesn’t?) it can help to have images that pop!  
Astrophotography is a tough area to make images pop 

because we are dealing with something that we don’t have 
a lot of – light!  Remember, photography by definition 
means “to write with light”.  Yet stars in a more or less black 
sky can make this challenging.  So, what can we do?

There are a couple things you can do to improve your 
astrophotography results.  First off, it helps to know some 
of the basics, so here are a few rules to go by when out 
shooting astrophotography.

1. Use a tripod. This should be pretty straightforward 

– We’re going to be dealing with long exposures here, and 
you’ve got to have a stable base for your camera.  Handheld 
attempts will not yield good results.

2. Turn on the in-camera noise reduction.  Most DSLR’s 
these days have a custom function that will reduce the 
amount of noise present in your pictures.  Since (as we just 
noted), we’re going to have long exposures, we’re also going 
to encounter noise.  So, let’s get a head start on minimizing 
that by turning it on in camera.  The menu settings vary 
from one camera to another, but typically will be under the 
category of Image Settings.  For instance, on the Canon 
40D (which I use), the long exposure noise reduction is 
under CF II – Image, and is the first sub-setting.

By Jason Anderson

How many times have you looked at the night sky, seen an amazing expanse of stars and just thought, 
“Hey, now that’d be a cool shot!”? From stars and nebula to comets and asteroids, then planets and 
galaxies, outer space is still a source of awe and wonder for so may of us it’s no doubt that when we 
capture images from this overly undiscovered frontier, it is surely to grab the viewer’s attention.

GETTING STARTED IN
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3. Drop your ISO to its lowest setting.  We’ll be 
fighting noise anyway, so why add it intentionally?  

4. Make sure you are working with fully charged 
batteries and have some spares! Depending on what 
you are going for, you could be outside for a long time 
and those long exposures (not to mention the in-
camera noise reduction) will suck the life out of your 
batteries fast!  

5. Try to shoot in a remote area where there is not 
much stray light. You also want to shoot in clear 
weather – clouds are your enemy because they can 
obstruct the view of the stars, so if there’s a chance 
of clouds, understand the implications of that and be 
prepared to possibly make a return trip.  If you are near 
a major city, go out to the suburbs.  In Colorado, that 
means I go into the mountains.  It helps here because 
not only is there less light noise, but it also makes for 
super clear skies!

There’s a lot more that I could go into as far as 
checklists go, but rather than just give bullet points, 
let’s also take a look at some of the premises behind 
astrophotography.  To start, it’s important to understand 
some of the concepts associated with working under 
these conditions too.

Stars move!

That’s right, just like the sun can appear to move 
across the sky as the day progresses, so do stars as the 
night progresses.  Why is this important?  Well, during 
the day, the subject of our photography is likely other 
objects that are also on the surface of Earth.  So, as we 
rotate around in our 24-hour cycle, the objects we are 
shooting move with us.

Stars, on the other hand, are not on the ground with 
us, so the subject of our photography is now moving.  
This is important to understand because that means 
we are going to encounter blur if we have to increase 
our shutter speed.  It might surprise you to know that 
if your shutter speed is over 5 seconds – the stars have 
likely moved from the position that you first shot them 
at.  Don’t believe it.  Try it!  A ten second exposure will 
show sharpness on the leading edge of your stars, and 
blur on the trailing edge.  This is what leads to motion 
blur from the stars – known commonly as star trails!

To Blur or Not to Blur – That is the Question!

So, in knowing that stars move, this means you 
have to make a decision.  Do you want to work with 
the blur that can occur and create some amazing 
artistic compositions, or do you want to minimize 
it?  Sometimes some super long exposures with a 

stationary tripod/camera setup can make for some 
amazing star trails.  If you’ve got the juice to go long 
enough (long exposures can drain batteries quickly), 
you can get entire circles of star trails.  

Alternatively, if you want to avoid the blur, you 
are going to have to take measures to counter-act this 
– usually with something called a star tracker.  You 
can get these for a pretty penny (I’ve seen some units 
that are pretty advanced going for upwards of $5000), 
or you can make your own if you are DIY inclined.  
Instructions are easy to find on the internet and with a 
little trial and error, you can get a pretty good system 
together of your own making for under $20 US.  In fact, 
I recently put one of these together and will be trying it 
out in the near future.  I’ve included some sample shots 
here of the setup, and if you’d like more detail, a link to 
the YouTube video follows at the end of this article.

Shoot the Moon – Or the Stars

While the moon and stars both occupy the same 
night sky, the methods for shooting them are very 
different.  The reason is because the moon outputs a 
lot more light than stars do – a lot more!  If you think 
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about it, this makes sense, after all not only is it closer to us geographically, but it also takes up more of our visual 
field.  This means you don’t need long exposures to capture enough light.

This also means that you don’t need to track the moon – you can capture it quickly enough where it won’t move 
perceptibly during your exposure.  In fact, in the case of shooting the moon, if you’ve got fast enough glass (think 
apertures of f2.8 or in that area), you could bump the ISO a little and possibly get a decent handheld shot!  I was quite 
surprised on my first lunar shot – the aperture was set to f8 and my shutter was at 1/100th of a second.  So, I dropped 
the aperture down lower, knowing I could thus increase the shutter speed.  When it still wasn’t quite enough to hand 
hold, I bumped the ISO to 400 and that allowed me to capture a handheld shot of the moon!  You’ll never be able to 
hand-hold a stellar photography shot, but lunar you conceivably could.  

Astrophotography is kind of a general (in my mind anyway) catch-all to include any shots of things in the sky.  I 
would make a distinction here between star photographer and lunar photography because the approaches are so 
different.  So, which do you want to shoot - the star or the moon?  Either way, the world (or universe in this case) is 
your oyster. 

For more information on how to capture the night skies, here are some of the resources I used in the writing of 
this article, along with a link to the YouTube video I put together on how to build a star tracker last month – enjoy!

Resources:
  •  http://www.popphoto.com/Features/How-To-Astrophotography-101
  •  http://www.astropix.com/HTML/I_ASTROP/TOC_AP.HTM
  •  http://www.geocities.com/capecanaveral/lab/6529/primer.html
  •  http://www.space.com/spacewatch/astrophotography_101_030627.html

YouTube Video
  •  Making a Star Tracker - http://www.youtube.com/watch?v=gCxze9qo6aY

This article and photographs contained are Copyright © and courtesy of Jason Anderson. Please contact the author directly with any questions.
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Any camera can capture shape and colour, but texture and form live in the world of 3D. As photographers, our 
problem is how to represent these components in a two dimensional image. The “SL” in DSLR stands for “Single 
Lens”: How can a “one-eyed” single lens device like a camera produce pictures that emulate the depth we perceive 
with our two eyes?

So, how do you know it is an Orange?

            1         2                3        4

Thankfully, as you can see there are clues in two dimensional representations that give the impression of form, 
primarily the shadows and highlights which are in turn functions of the optical rules of a photographic artist’s true 
medium, light! 

Careful use of lights in portraiture can flatter or emphasize the form of the human face.

PORTRAIT LIGHTING FORM:  By John Ogden

Portraiture Photography 101
TIPS AND TECHNIQUES FOR STUDIO AND PORTRAITURE PHOTOGRAPHY AND LIGHTING

Form: Definition (n.) how an object occupies space. Whatever the medium used; acrylics, water 
colour, oil paint or charcoal, over the years artists have developed techniques to help render visual 
information in an accessible way. In art and visual design there are traditionally four components 
used to organise or present visual information; shape, colour, texture, and form. Of these, form 
is probably the most elusive.

1. Presented with a circular shape we are beginning to understand what this object looks like, but of course 
the bottom of a pear or even the end of a banana is the same shape!

2. Colour is a big clue and really starts to narrow down the subject in this case!

3. Not until texture is introduced by the interplay of shadow next to highlight, does it become clear what 
we are looking at. Even then only because we already have colour and shape. In the absence of colour this 
could easily be a lemon or lime.

4. Side lighting reveals the spherical form and gives the final clue to what we are presented with here



Pa
ge

 23

PhotographyBB Online Magazine

More Jargon:

The “quality” of light usually refers to how soft or how harsh the light is. A straight bare bulb will cast hard 
edged shadows, whereas shining the light through a diffuser, umbrella or soft-box results in shadows with softer 
feathered edges. Generally, harsher light adds volume and weight to the form.

          1                2

Test answers: 1. Key light.  2. Broad.  3. Nose.  4. Accent.

 Test Yourself! (Answers at the bottom of the page):

What can you remember from last month about lights used in portraiture?

1. What is another name for the main light used in portraiture?
2. What is the general name given to the portrait lighting style when the main light illuminates the side of the 
face nearer to the camera?
3. Which facial feature casts the most significant shadow?
4. What is the general name for additional lights often placed behind the subject facing towards the 
camera?

1. In the first image this apple is illuminated by a single desk lamp off to the left. The resulting shadow is hard 
edged and you can see the blown highlight where the light is reflected in the shiny surface.

2. In the second image a white reflector is used as a diffuser in front of the same light source effectively 
making the light bigger: just as clouds diffuse direct sun light. The light now wraps round the apple and 
produces a softer edged shadow. Overall this image has less contrast due to this softer quality of diffused 
light.
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Types of “Modifiers”

Lights for portraiture can also be modified by a number of add on accessories, (or modifiers) to change the 
quality and contrast or refine the effective area covered by the light.  

Examples:

For this short lighting portrait of Dominic I have a shoot-through umbrella on the key light which also spreads 
onto the white background. The harsher fill light picks up texture in the coat and also illuminates the backdrop.

You can see the difference in the quality of light here. The unmodified fill light is throwing a harder edged 
shadow on Dominic’s right cheek and chin.

Soft box Usually large square or octagonal arrangements, designed to produce an even 
spread of light on the subject.

Umbrella Another diffusing device. Can either be used to reflect light or to shine light 
through.

Snoot A hard metal or plastic funnel used to isolate the light to specific areas, creating 
a spot light effect.

Barn doors Four hinged metal plates that fold down in front of the light source to fine tune 
where the light falls.

Honeycomb or  “Egg crate” An add on available in various sizes that narrows the beam creating a smaller, 
harsher light source
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Soft Box Accent Lighting:

In this illustration, the light shown is an accent light produced by using a soft 
box fitted with an egg crate (the grid you can just make out on the light). 

You can see the resulting effect on the models arm and hair and on the tripod 
in front of her. 

Used in combination with key and fill lights this would add depth and drama 
to the final image.

  I have included these two pictures of Jessica to show how the fill light is used to “fill in” shadows. In the first picture 
on the left the main flash did not fire, so all you can see is the effect of the fill light in isolation. See how good I am 
sharing my mistakes with you?

Even with the limited visual information in the faulty image, we know it’s a person as the side lighting reveals the 
illusive form and texture.

Try it yourself!

Try modifying the light next time you shoot portraits. If you don’t have access to the types of accessories listed above 
you can use a white sheet or board as a diffuser or bounce light of a white wall for a similar effect. 

Your camera records what you see, so learn to see the light. Learn to see how the light will help “form” translate into 
two dimensions

Until next time..keep shooting! 

This article and images contained are Copyright © and courtesy of John Ogden. Please contact the author directly with any questions.
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Digital Photography 101

PANORAMIC PHOTOGRAPHY TECHNIQUES:  By David Hegarty

This is the first in a two-part article on panoramas. I enjoy doing panoramas because they give a 
totally different view of the world. I have also found that the software can be very useful, sometimes 
in unconventional ways, including: Removing people from a scene, increasing depth of field, and 
scanning documents that are larger than my scanner. This first article is about your traditional 
panorama; I have kept things simple with some links to more comprehensive information.

Software:
The software I use for stitching panoramas is Adobe 

Photoshop (CS3/CS4). If you don’t have Photoshop, 
there are some free options for stitching panoramas:

Autostitch - Free and simple.
http://www.cs.ubc.ca/~mbrown/autostitch/
autostitch.html

Hugin - Also free, but more complex, and a good 
option if you are interested in making full spherical 
panoramas.
http://hugin.sourceforge.net/

Photoshop may seem overly simple compared to 
Hugin, but once you learn a few tricks then it is very 
powerful and versatile.

Camera:
Ideally, you want a camera that has manual control 

over focus, exposure, and white balance. Any SLR will 
work quite nicely but don’t despair if you are using a 
point & shoot. The P&S camera will still produce a nice 
landscape panorama.

Lens:
A normal kit lens will do the job. I usually shoot 

with my kit lens at 17mm (with a crop sensor).

Tripod:
One of the biggest problems in creating 

panoramas is something called parallax. This is quite 
easy to visualize: Hold up your index finger and close 
one eye. Now move your finger so that it obscures an 
object like a door at the far side of the room. Without 
moving your finger, rotate your head from side to side. 
The background will look like it moved relative to your 
finger. There are two things that control how strong 
this effect is:

1) The closer the subject is, the stronger the effect.
2) The further away your eye is from the centre of 
rotation, the stronger the effect.

So when taking the photos you want to keep the 
camera rotating around a fixed point and everything 
far away (outdoors is good). You can shoot indoors, 
but you have to be much more careful about the 
centre of rotation. You can even get a special tripod 
head that rotates the camera about the exact point to 
avoid parallax. This point depends on your camera and 
lens combination but it is approximately the centre of 
the lens. The amount of parallax you get by rotating 
around your tripod screw mount would be similar to 
when you rotated you head earlier. This amount is 
totally acceptable when outdoors as everything is far 
away.

A COMPREHENSIVE GUIDE TO UNDERSTANDING DIGITAL PHOTOGRAPHY TECHNIQUES  AND CONCEPTS
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If you want to do interior panoramas then a 
panorama head is worthwhile looking at (PANOSARUS 
http://gregwired.com/pano/Pano.htm is good value). 
Doing panoramas outside however is much easier and 
a regular tripod works well. Modern software is so good 
at fixing errors that half the time I don’t even bother 
with a tripod, and shoot handheld instead.

Filters
I often use a 2 stop ND graduated filter when 

shooting landscapes. They work well in single row 
panoramas, but they can cause problems if you don’t 
keep them level with the horizon. If the ND grad is 
tilted to one side then all the pictures will look uneven 
when blended together.

 

It is generally recommended to avoid using 
polarizing filters when doing panoramas. They darken 
the sky but their effect is relative to the angle to the 
sun. Panoramas typically cover a wide angle and the 
strength of the filter will change between different 
shots. This results in having a sky that changes its 
appearance half way through your panorama.

How to Shoot with a DSLR:
When shooting panoramas you want nice 

consistent lighting. Shooting outdoors with your back 
to the sun is ideal. When you shoot into the sun you 
tend to get blown out skies and dark foregrounds.

1. Set the zoom on your lens. I always shoot wider than 
I actually need, as the stitched panorama will always 

need cropping (widest setting on a kit lens works well).
There is no need to zoom in to get higher resolution; 
A 180 degree panorama taken at 17mm (crop sensor) 
would be about 4 feet long when printed at 300DPI.

2. Set your focus (I use auto-focus at a suitable distance 
and then switch to manual focus to prevent the camera 
from attempting to re-focus with each shot). If you 
decide to change your zoom, then you should refocus 
again.

3. If you shoot in jpeg then set your white balance. If 
you shoot in raw then it’s easier to synchronize the 
white balance later.

4. Go to manual exposure on your camera. Set your 
aperture to around f16 for good depth of field and adjust 
the shutter speed and ISO to get good exposure. 

For good panoramas you want to keep the exposure 
constant across all the photos. However, If you do need 
to change the exposure then change the shutter speed 
only - don’t change the aperture / DOF.

5. Put your camera on a tripod and make sure it is level. 
If it isn’t, you’ll wind up with a distorted panorama that 
needs very heavy cropping. 

If shooting by hand I usually stand in one spot and turn 
in a circle. Keeping the camera at my eye will ensure 
that the photos are all level and will reduce stitching 
errors. The more the camera moves the more stitching 
errors you get, so don’t hold the camera away from the 
body.

6. I usually keep the camera vertical (portrait) to get 
extra height from my panorama. It is probably easier 
to shoot horizontal (landscape) but I find that the 
panoramas tend to be very narrow. 

You can shoot multiple rows to get extra height but 
that makes it much easier to make a mistake. For 
example you could start your first row at the ground 
and set your exposure accordingly. Then you move to 
the sky and you find that the sky is totally blown out. 
Shooting a single row with a two stop ND Grad filter 
would be much easier and get better results.
 
7. You want about 25% overlap between all the photos. 
There is a simple way to sure that you get good overlap. 
Start at the far left of the scene and take the photo. 
Look at the right of that image and choose a significant 
object like a tree. Then you rotate your camera to the 
right and make sure that the tree is clearly visible in 
the left of the next frame. Continue shooting in this 
fashion until you have all of your shots that you will be 
stitching together in the panoramic software.
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How to Shoot with a Point and Shoot Camera:
Your camera may have a panorama mode - check 

your manual for details on how to use this feature. If 
you don’t have a panorama feature in your camera, 
you should switch it to landscape scene mode. You 
don’t have the full control that SLR users have but 
scene modes work quite well. You want to give your 
camera nice lighting conditions, so again, shoot with 
your back to the sun. That way your photos will all have 
consistent lighting. You probably won’t have a tripod 
either but you can shoot by hand. Stand in one spot 
and rotate the camera with your hands as if you are 
the tripod. If it gets dark then put in on a wall and use 
a 2 second timer; it will work just as well as the most 
expensive tripod.

Synchronizing all your RAW Photos (from a 
SLR or fancy P&S):

I always shoot in RAW because it is so very easy to 
fix problems with exposure and white balance. I use 
Adobe Camera Raw for editing my photos but there 
are other alternative packages that are just as good. 
I also use Adobe Bridge to sort and edit my images. 
Bridge is installed with Photoshop and provides much 
of the functionality that you would associate with 
Adobe Lightroom. If you have the money and do a lot 
of shooting then Lightroom is a better option.

1. Select all your photos in Bridge. (Ctrl or shift to select 
multiple photos)
I usually give these photos a rating or label to make 
them easier to find later. Ctrl - 1 to 9 

2. Ctrl-R to open all the photos in Camera Raw (ACR)

3. At the left side you will see all you images as 
thumbnails. Choose a representative image from the 
centre of the panorama.

4. With this image I set a custom white balance and 
apply some sharpening. I generally add a good bit of 
sharpening as the images can tend to be softened a bit 
by the photomerge process. I also check for chromatic 
aberration and lens vignette. It is much easier to fix 
these now, than to wait until after you stitched the 
panorama.

5. Up the top left I click on “select all” then on 
“Synchronize”. This allows me to apply the settings to 
all the images

6. All your images should be looking pretty similar 
now but sometimes a photo might be darker than the 
rest. Lighting conditions are always changing so your 

photos will never be 100% the same. If a photo is too 
bright or dark, then I will try to make it more similar 
to the other photos. There is no problem editing that 
image separately so long as you leave the synchronised 
settings (white balance, sharpening etc.) alone.

7. Click “done” to go back to Bridge.

8. It is possible to stitch the panorama directly from the 
raw files, but this can be very slow on older computers. 
If all you want is to put you panorama on Flickr then 
we don’t really need to create a full size panorama. 
Sizing things down to about 25% scale makes things 
much simpler for your computer and easier to view on 
a computer screen. With your images still selected in 
bridge go to: Tools > Photoshop > Image Processor.
 

This very useful window will take all the RAW images 
and resize them down to 1000pixels. Then it will save 
them as jpegs in a new sub-folder called JPEG. You also 
have the option to run an action. We don’t need to do 
any actions here but this is extremely handy for making 
watermarked proof photos for a wedding.

Select all your images and go to: Tools > Photoshop > 
Photomerge

Stitching the photos in Photoshop CS3/CS4:
1. File>Automate>Photomerge

2. Layout - Auto (it is usually the best option).
Perspective - for narrow panoramas (icon shows what 
to expect from the un-cropped stitch).
Cylindrical - for wide panoramas (usually for panoramas 
wider than 4 images).
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Auto will choose between perspective and cylindrical layouts so we never have to pick which one to choose
There are other layout options depending on if you are using CS3 or CS4 but I use Auto 99% of the time.

3. Select the photos using browse. (Ctrl or shift to select multiple photos)

4. Turn on blend. CS4 introduced “vignette removal” and “geometric distortion correction” which would improve the 
results from wide angle lenses but I usually leave them turned off.

5. Click OK and have a nice cup of tea while you computer does all the work. It might take some time, especially on 
older computers. 

Next Month:
I hope you have enjoyed the first part in this two-part series on panoramic photography. In next month’s article 

I will cover how to fix any stitching errors and how to use the panoramic software in some interesting ways, so in the 
meantime, get busy and practice shooting your panoramic shots!

This article and all images contained are Copyright © and courtesy of David Hegarty. Please contact the author directly with any questions.
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Step 1:
Open the image you’re going to work on. I’m using a 
picture of my beloved and myself in Egypt. (As in all the 
holiday snaps I appear in, I look somewhat bedraggled 
and have a camera bag and tripod hanging around my 
neck, but enough about my problems!)

Step 2: 
The first step is to crop the image down to size. Old 
instamatic Polaroid were basically squares with a frame 
around them. So I’ll crop the image to a square in the 
area I’m interested in. 

Select the Crop Tool (C) and drag out a square. To get a 
perfect square, hold down the Shift key as you drag.

 The area outside the crop will appear in a darker colour 
so you get a preview of what you’ll be chopping off 
your photograph. When you’re happy with this, press 
Enter/Return on the keyboard.

POLAROID STYLE WITH A HANDWRITTEN NOTE:  By Jennifer Farley

Adobe Photoshop® Tutorial
TECHNIQUES, TIPS, AND TRICKS FOR DIGITAL EDITING OF IMAGES IN PHOTOSHOP®

This month, we’re looking at how to take an image, crop it down to size, then re-crop UP in size 
to create extra canvas to produce what looks like an instamatic Polaroid style image. To finish it 
off we’ll also add some handwritten text. 
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Step 3:
Now we’re actually going to ADD some extra canvas to 
what we have just cropped. This is a little trick with the 
Crop Tool that a lot of people miss. 

Press D on the keyboard to set the Foreground colour 
to black and the background colour to white.

Drag out a crop to cover the whole of your image. Then 
on the centre handle at the top, drag out the crop so 
that it is now larger that your image. Do the same with 
the handle on the left and right side. Drag the top and 
sides so that there is an equal amount of space around 
the image.

Step 4:
Now we’re going to extend the canvas at the bottom. 
Drag the handle in the bottom centre downwards, but 
this time, leave about four or five times more space 
between the bottom of the picture and the crop that 
you’re dragging down.

Press Enter/Return and voila! You will have a nice white 
frame around your square image. 
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Step 5:
Now we’re going to add some text to the bottom of 
the image. If you wanted you could write something 
on a piece of paper in your own handwriting and scan 
it in. Alternatively you could use a handwriting style 
font and just add it using the type tool. That’s what 
I’m doing here. I’m using a font called Dead Man’s 
Handwriting which is available to download free from 
DaFont.com. After you install it with your other fonts it 
will be available for you to use in Photoshop.

Select the Type tool (T), set the Type Options to the 
colour that you like, size and font, then click once at 
the bottom of the image to add your text.

Step 6:
Select your image and the text by pressing Ctrl + A (Win) 
or Cmd + A (Mac). Then choose Edit > Copy Merged. 
It’s important that you choose Copy Merged rather 
than just Copy, because this will pick up everything 
that’s visible on image, no matter how many layers are 
involved.

Step 7:
Create a new Photoshop file by pressing Ctrl + N / Cmd 
+ N. When the New File dialog box opens, Photoshop 
will display the dimensions of the image you have just 
copied. Click OK.

Step 8:
Now choose Edit > Paste to paste your image into 
the new file. The complete image, including text will 
appear on a new layer. We’re doing this because I want 
to scale the image down and rotate it.

Step 9:
Choose Edit > Free Transform. A bounding box with 
handles will appear around the image. Hold down Shift 
and drag one of the corner handles so that the image 
scales down in size proportionally. 

Don’t hit Enter/Return yet. While the bounding box is 
still around the image you copied, drag the whole lot 
into the centre of the document.
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Step 10:
Now bring your mouse close to the outside of one 
of the corner handles so that you can see a double 
rounded arrow. This lets you know that you can rotate 
the contents of the bounding box. Click and drag so 
that the image starts to rotate. Then press Enter/Return 
to complete both transformations.
 

Step 11:
To finish up, we’ll add a drop shadow. Click on the 
Layer Effects icon at the bottom of the Layers palette 
and choose Drop Shadow from the drop down box.

The Drop Shadow dialog box opens up. Make sure that 
you check the “Preview” box so that you can see the 
effect.

I reduced the opacity of the shadow to about 40% and 
made it a dark grey, rather than black. The settings for 
Distance, Spread and Size will really vary depending on 
the size of your image. This is something you can judge 
by eye and decide how you like the drop shadow to 
look. I did make the Spread quite large so that I could 
see some drop shadow the whole way around the 
image. 

When I was happy with how it looked, I clicked ok. And 
my final image looks like this:  

You could do this with a few of your photographs from 
a holiday or event and create a scrap book effect by 
placing them all inside one large image.

I hope you have enjoyed this tutorial on making 
Polaroid style images. Join us next month where we’ll 
have a look at another black and white conversion 
technique using the Lab colour mode.

This article and images contained are Copyright © and courtesy of Jennifer Farley.  Please contact the author directly with any questions.
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PBB: Welcome to PhotographyBB, and thank you for 
joining us today. Why don’t we start by getting to 
know you better - tell us about yourself John!

Hello Dave and hi readers! Let me start by saying 
that I am honored and somewhat surprised to be 
asked to do an interview for this publication. I’ve read 
the interviews of other photographers you’ve had in 
past editions and I am now feeling a little bit like a deer 
in the headlights. I have to be totally honest and say I 
don’t consider myself a photographer; rather I dabble in 
photography as a hobby, which is why I am somewhat 
‘gob-smacked’ to be asked to do this (go look it up if 
you don’t know what that means!). 

OK – so a little about me. I’m 45 years old, originally 
from England, but have for the past 5 years (or 
thereabouts) lived and worked in California. I’m married 
to a wonderful woman who is remarkably tolerant of 

my hobby and the amount of time I have been sinking 
into it of late. We have 4 children (all now grown up) and 
3 grandchildren (with a 4th on the way). My youngest 
two daughters (now 18 and 20) live with my wife and 
I in California, and the eldest two (now 22 and 28) live 
back in the UK, so we are a geographically dispersed 
family. This has its own challenges but we have used 
photography as a means of keeping one another up 
to date with things that have been happening in our 
lives. 

I’ve been involved in the computer industry 
for pretty much all of my working life, focusing on 
computer networking, and the sharing and storing of 
data in distributed networks. My interest in this aspect 
of computing drove me to take a position around 10 
years ago with what was then a relatively small but 
interesting data storage company who were based in 
California but had a fledgling operation in the UK. After 

PhotographyBB is pleased to welcome John Krzesinski to the spotlight chair this month. John comes to us via 
our Flickr group (PhotographyBB_Gallery) and was recommended for the spotlight by our good friend and Flickr 
moderator Sue. John has a rapidly growing fanbase on Flickr, due to his unique style and spectacular shots.

 THIS MONTH’S SPOTLIGHT INTERVIEW: John Krzesinski

Photographer in the Spotlight
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5 years with them I was approached to take a position 
at their corporate headquarters in Silicon Valley, and 
so after much discussion as a family we moved to 
America. I like to think of this as my response to my 
mid-life crisis! 

I love photography, computing, cycling, camping, 
hiking, wildlife watching and travel and I’ve had a lot 
of fun exploring all of these more since moving to 
California. I’ve been taking pictures since my teenage 
years, but it’s only in the past year or so that I’ve started 
to use photography as anything other than a way to 
simply preserve memories.

PBB: Tell us about your gear! What equipment do 
you use, and is there any piece of gear that you 
ALWAYS bring with you on a shoot?

For the second part of this question I’m very 
tempted to just answer this with a tongue-in-cheek 
response of “my camera”, but to be honest that isn’t 
that far from the truth. My collection of shooting 
equipment is relatively small – until relatively recently 
all I had was a compact point and shoot camera. I 
upgraded after my youngest daughter started playing 
basketball in high school and I found that my little P&S 
just couldn’t cope with the poor lighting inside the 
gyms that the teams often played in, and so I upgraded 
about 3 years ago to my first DSLR – a Nikon D40x. For 
about a year from then my kit was basically the content 
of the camera kit that I purchased, which was the D40x 
itself, and the two lenses it came with (the Nikon 18-
55mm, and 55-200mm) and while I started learning 
how to use the camera this was more than enough for 
me. Then early last year my wife and I decided to visit 
China to celebrate our 25th wedding anniversary, and 
so I convinced my wife that I should get a better zoom 
lens so we could be sure to get better photographs of 
this once in a lifetime trip, so I got a Nikon 70-300mm 
lens to take with us. I’ve added little things to my kit 
over time – a tripod (present from my wife), a 50mm 
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f/1.8 lens, remote control, flash-gun, a small selection 
of filters. Earlier this year I upgraded from my D40x to 
the new D5000 (my wife now uses the D40x), and also 
got an 18-200mm lens so I can be more flexible while at 
the same time travelling light when hiking or cycling.

So to answer the question – I always have with me 
my D5000, 18-200mm lens, and 70-300mm lens, and a 
spare (charged) battery unless I’m travelling really light 
in which case I leave the 70-300mm lens behind!

My full kit list (such as it is) is as follows…
Nikon D5000
Nikkor 18-200mm f/3.5-5.5 G ED AF-S VR lens
Nikkor 70-300mm f/4.5-5.6 G AF-S VR lens
Nikkor 50mm f/1.8 D lens
Nikkor 18-55mm f/3.5-5.6 G AF-S VR lens
Nikon SB-600 Speedlight
Nikon ML-L3 remote control
UV Filters
Circular polarizer filters
+10 macro filter
Extra SD-HD cards (camera has a 32GB card in it!)
Spare camera battery pack
Spare set of AA batteries for flash
Quantaray tripod
Tamrac laptop/camera rucksack

PBB: How long have you been into photography, and 
can you recall what first got you into photography? 
What is your artistic/photographic background?

My answer really depends on your definition of 
“into”. I’ve been taking pictures since I was a young 
teenager, but really only as a means of remembering 
the places I would visit and the people I would meet. 
Having said that, I didn’t just take “snapshots” – I always 
had a desire to compose the shots and try and get 
something that I would actually enjoy looking at later. 
It was really only after I got exposed to using a DSLR 
though that I started getting “into” photography and 
exploring what I could do other than just supplement 
my memory, so I guess to answer your question I 
would say that I’ve been “into“ photography for about 
the last 2 years. What (or perhaps I should say who) 
first got me into taking pictures was my Mother (may 
she rest in peace). She gave me my first camera, and 
would take me on interesting trips and encourage me 
to take photos of what we would see. It is through her 
encouragement that I started to appreciate the beauty 
in the world around me. She also first exposed me 
to the Western United States, when as a 14 year old 
teenager eager to explore the world she took me on 
a 3 week coach tour that covered a large chunk of the 
Western USA including much of California, so I also 
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have her to thank for starting the spark that led to my 
desire to live where I now do. With her passing earlier 
this year I found myself drawn more to photography 
and nature, partly as a means of escape, but also as 
a means to remember her by. I am totally self-taught 
and have barely scratched the surface of what I could 
do with the tools I have available. I’m sure with some 
proper tuition I could achieve a lot more than I do now, 
but for now I’m happy with what I am doing.

PBB: Your Flickr gallery has really achieved quite a 
following of fans of your work! You also exhibit quite 
a diverse range of subjects in your photography. 
Do you have a favorite photographic discipline (ie. 
Landscapes, portraiture, nature...)?

Thank you. The underlying theme in my 
photography is capturing the (sometimes hidden) 
beauty in the world around us, whether it be landscapes, 
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flora, and/or fauna. I enjoy the challenge of natural 
wildlife photography, and inspired by a childhood of 
watching Johnny Morris in Animal Magic I particularly 
love trying to capture shots of animals in quirky, funny, 
or silly stances. I don’t like unnaturally posed shots – I 
much prefer to capture things “as they are”, whether 
they be people or animals. I do try and maintain some 
variety in what I shoot, but often fall back to wildlife 
photography as it blends a number of my favorite 
things. I also enjoy photographing the moon, and have 
had a lot of fun trying to get “the perfect moon shot” 
with the equipment I have.

PBB: Could you tell us a little bit about your “Photo 
a Day” project that you are working on?

Well it was really inspired by seeing others on 
Flickr doing the same. It seemed like a good idea to 
get me taking pictures of things I might not normally 
photograph, and to (hopefully) help me become more 
proficient at using my camera. I’ve been trying to mix 
up the subjects as I go and not repeat things too often, 
but I have found that keeping to the spirit of the project 
has been challenging as my family and work life often 
leave me little time to be truly original. I’m now well 
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over half way through the project and am determined 
to stick with the project to the end of the year (I started 
on January 1) but I can’t see me wanting to repeat the 
project next year. It has been fun – it’s made me think 
a lot more about what I am taking pictures of, and it’s 
given me the opportunity to experiment with different 
subjects that I might otherwise not have thought of, 
and if others are thinking of ways to further explore 
photography I would recommend they consider taking 
on such a project themselves.

PBB: As with many photographers, there is a debate 
on the issue of getting things right “in-camera” vs 
post processing after the fact. As a photographer, 
what are your thoughts on this?

In a nutshell, “it depends.”  I know – a very non-
committal response, but let me explain. Ideally I like my 
photography to be straight out of the camera. I’m not a 
fan of HDR or some of the other heavy post-processing 
you see a lot across on-line photo-sharing forums 
such as Flickr. If I want to use an effect for a shot I’d 
prefer to learn how to do it with the camera than edit 
it in later. But… especially with shooting wildlife you 
often have little time to think about setting the camera 
correctly for the perfect shot, and so I will use what 
seems to be the most appropriate pre-set mode on the 
camera, concentrate on getting a shot of the subject 

in question and then if it’s not quite right I’ll tweak it 
later. My philosophy being I’d rather come away with a 
photo that might need a little work later than miss the 
shot altogether because I’ve spent too long trying to 
find the perfect settings.

PBB: Do you have any particular photographic 
achievement which you are most proud of? What 
are your photographic plans for the future?

Because my photography has really been for my 
own enjoyment I’ve not gone out seeking ways for 
my work to be published. To be honest I am very self-
critical and haven’t really believed that my work is good 
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enough to try and have published, but many have told 
me otherwise and that’s partly what drew me to Flickr, 
which I have been using as a way to test the waters and 
see how others around the world see my work. With 
this in mind, I was pleasantly surprised at the reception 
that many of my shots have had from others on Flickr, 
and this in turn has driven me to try and improve my 
work. I am proud that a number of my photos from my 
various hikes around some of the wonderful parks we 
have in the East San Francisco Bay area have been used 
by the East Bay Regional Parks District on their web 
site, and I have just found out that as I do this interview 
one of my shots has made the finals of the annual Bay 

Nature Magazine photo contest (the final results will 
be made available at the end of August – I’m keeping 
my fingers crossed). Also, through Flickr I have been 
approached by a number of non-profit organizations 
who have wanted to use some of my photos in various 
publications. As I take pictures for my own enjoyment, 
every time someone else likes my work enough to want 
to use it in some way just adds to that enjoyment… 

My proudest moment though was last year. With 
my youngest daughter playing basketball for her high-
school team, and with me attending each game and 
taking pictures through the season, I was asked by the 
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coaching staff if I’d mind producing the slide-show 
for their annual basketball awards banquet. As I was 
there taking pictures anyway, I was happy to oblige, 
and so rather than just taking photos of my daughter I 
made sure I had a good selection of each of the players 
across the three teams. At the end of the season I went 
through all the shots and pulled together a selection 
that showed the teams in action (technically not 
perfect but then they would be projected using a low 
resolution projector so that didn’t matter too much), 
and put them together with some appropriate music. 
Once finished I passed the resultant work to the head 
coach and moved on to other things. Come the night 

of the awards banquet, we sat with our daughter 
and the rest of the team members and their families 
and I cringed slightly as I was thanked for my work in 
advance of the slide-shows being played, but the cries 
of “oooh”, “wow”, the rounds of applause, and then the 
ovation at the end of the last slideshow really showed 
how much my work was appreciated by the girls and 
their parents. 

As to plans for the future, I’m not really sure… I’d 
like to somehow turn my hobby into at least a small 
income stream so I can afford to expand my equipment 
and not feel guilty about doing so! Also, based on the 
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feedback I’ve had from many on Flickr with regards to 
my photos, I’d like to see how I can have some of my 
work appreciated by a wider audience. I’m really only 
just starting out on this journey. I feel like a teenager 
who has just learned enough about driving to pass 
their driving test and who armed with a driving license 
and a car now has a future of driving ahead of them… 
It’ll be interesting to see where the journey takes me in 
the coming years.

PBB: What advice do you have for our readers who 
are either beginners to digital photography, or 
those aspiring to become better photographers?

Of all the questions, I find this one the hardest to answer, 
as I consider myself as a beginner and someone who is 
themselves aspiring to become a better photographer, 
but here’s what I have to offer...

First and foremost be true to yourselves. The moment 
you feel you are doing something just for the sake 
of others is probably the time to think about doing 
something else. Photography is like any other art-form; 
it’s about self-expression. Don’t be afraid to experiment 
and try new things; like anything in life, the comment 
of “you won’t know whether you like it or not unless 
you try it” applies as much to photography as it does to 
trying to convince your 4-year-old to eat some type of 

foreign food for the first time. Most importantly though, 
don’t think that because you haven’t got thousands of 
dollars worth of equipment that you can’t take good 
pictures. One of my favorite photographers on Flickr 
manages to shoot awesome pictures using camera 
that cost about the same as my flash. Photography is 
about the subject and the composition. The camera is 
merely the tool. Obviously good, expensive tools can 
make the job easier, but a good camera does not make 
a good photographer. A good photographer will be 
able to capture an eye-grabbing image whether they 
are using $300 P&S, or a $3000 high-end DSLR.

This article and photographs contained are Copyright © and courtesy of John Krzesinski. Please contact the author directly with any questions.
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The 15th photography assignment theme was to go out and take a photograph that represented the signs that the spring season 
is upon us. Given the unusually long winter that many of our readers experienced, this task proved to be quite challenging. Our 
members rose to the occasion and came up with some great shots to show that spring is indeed upon us! Here are our top picks.

Photography Assignment Challenge Picks!

Doors are always an interesting subject to shoot. While doors are all around us, the real challenge is to find an interesting door as a 
photographic subject, then find the best way to photograph it making use of the available light and composition techniques. Here 
are the top selections for the “Doors” assignment, and thanks to all of our participants.

PHOTOGRAPHYBB PHOTO ASSIGNMENTS CHALLENGE #19: DOORS

Photography Assignment Challenge Picks!

Left: Photo by member Fryeme. Top Right: Photo by member Frosty.  Bottom Right: Photo (cropped) by member Debrasue.
Thank you to all of our photography assignment participants. We look forward to your submissions in our ongoing bi-weekly assignments.
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The 15th photography assignment theme was to go out and take a photograph that represented the signs that the spring season 
is upon us. Given the unusually long winter that many of our readers experienced, this task proved to be quite challenging. Our 
members rose to the occasion and came up with some great shots to show that spring is indeed upon us! Here are our top picks.

Photography Assignment Challenge Picks!

Inspiration was the theme of this assignment. This was probably one of our most challenging assignments, since “inspiration” 
means something different to each individual. What exactly did our members find as an “inspiration” to them in their photography 
and/or lives? Here are the top selections for this challenge, and once again, thanks to all of the members who submitted an entry.

PHOTOGRAPHYBB PHOTO ASSIGNMENTS CHALLENGE #20: “INSPIRATION”

Photography Assignment Challenge Picks!

Top: Rainbow over Sarajevo by member “alwanda”.  Bottom Left: Life Stages by member “Sue90”. Bottom Right: Grandmother’s Cross by member “kathywinter”.
Thank you to all of our photography assignment participants. We look forward to your submissions in our ongoing bi-weekly assignments.
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PhotographyBB flickr Group Member Photos
The PhotographyBB Gallery group on flickr® is the latest place for flickr® members to participate in PhotographyBB 
Assignments. Each month, in addition to choosing our top photos from the PhotographyBB Forum submissions, we’ll also 
be selecting some images from the talented members of our flickr® group to showcase their photography. Click on the links 
under each photo to view the flickr® gallery of the photographer who submitted the photo.

Top Left: “Best of May Photo” Spider Web Drops- fotobird1
http://www.flickr.com/photos/fotobird_1/

Top Right: “Doors” - Box of Frogs (Paul Hodgson)
http://www.flickr.com/photos/hoddo1812/

Bottom Right: “Inspiration: Mother & Son” - 00kell
http://www.flickr.com/photos/27944205@N03/

Bottom Left: “Inspiration: Nature’s Beauty” - bev1945
http://www.flickr.com/photos/15008047@N06/
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Do You Have a 
Great Idea for 

a Photography 
Article?

We are looking for 
talented individuals 
who would like to 
expand their portfolios 
by volunteering to 
contribute articles to 
this e-magazine! If you 
are interested, we’d 
love to hear from you.

Topics of Interest are:

- Photography Techniques
- Photography on Location
- Photoshop Tutorials
- Hardware / Software Reviews
- Camera Equipment
- Member Spotlight
- Plus we’re open to new ideas!

To become either a regular 
contributing author, or even 
just for a one-time article, 
please email us at: 

magazine@photographybb.com

Introduce yourself, share your 
idea, and maybe we’ll see you 
in next month’s issue!

Step into the Spotlight!
Would you like to be featured in the PhotographyBB 
Online Spotlight on Member section? If so, please let 
us know at: magazine@photographybb.com

We’ll feature your photos, a small biography and write-
up about you, as well as links to your web gallery or 
photography related business. We all love photography 
and image editing, so let’s get to know each other!

Been Around the World?
We are looking for talented writers who would like 
to share their experiences in visiting far away places, 
or even your home town for that matter. In our 
Photography Around the World column, we take our 
readers on a photographic journey, and we would like 
you to be our tour guide.

If you would like to share your story and photography 
of a city you have visited, please contact us and share 
your idea with our team. We’d love to hear from you!

RSS Updates Available:
There have been some requests for email notifications  
of upcoming issues of the PhotographyBB Magazine 
Online. You can receive updates on the magazine as 
well as our blog postings through our RSS feed which 
can either be aggregated to your feed reader, or 
emailed to your email address. Any of our readers who 
are interested can subscribe here:
http://feeds2.feedburner.com/photographybb

Discounts for Readers:
For those of you who are interested in getting into HDR 
photography, there simply is no better HDR software 
then HDRsoft’s Photomatix Pro, available as a stand 
alone software and as a Photoshop Plugin. Visit:
http://www.photographybb.com/hdr/
and use the coupon code: photographybb.com 
for a special discount. Also, check out the Shop 
PhotographyBB site for links to some great deals on 
cameras and accessories. Best deals on the web!

Thank you for reading the PhotographyBB Online 
Magazine. We hope  you enjoyed it, and we’d love to 
see you again next month. If you have any questions or 
comments for us regarding this magazine, please feel 
free to email us at: magazine@photographybb.com


